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Customizing the Cisco Unity Platform

In this chapter, you do the following tasks in the order listed:

1. Use the Cisco Unity System Preparation Assistant to install required Windows components, the 
browser and database, and required service packs. See the “Running the Cisco Unity System 
Preparation Assistant” section on page 5-2.

2. If the system is using MSDE 2000: Install Enterprise Manager, and set the MSDE system 
administrator password. See the “Installing Administration Software for MSDE 2000 and Setting 
the MSDE System Administrator Password” section on page 5-5.

3. Install the latest Microsoft service packs and updates for Windows and for SQL Server 2000 or 
MSDE 2000 that are recommended for use with Cisco Unity. See the “Installing the Latest 
Microsoft Service Packs and Updates for Windows and SQL Server 2000/MSDE 2000” section on 
page 5-6. 

4. Disable the Found New Hardware wizard, if applicable. See the “Disabling the Found New 
Hardware Wizard for the Voice Cards” section on page 5-7.

5. Optional: Install virus-scanning software. See the “Installing Virus-Scanning Software (Optional)” 
section on page 5-8.

6. Optional: Install and configure Cisco Security Agent for Cisco Unity. See the “Installing and 
Configuring Cisco Security Agent for Cisco Unity (Optional)” section on page 5-8.

7. Connect the Cisco Unity server to the network, if applicable. See the “Connecting the Cisco Unity 
Server to the Network” section on page 5-8.

8. If the Cisco Unity server contains dual NICs: Configure the dual NICs or verify their configuration. 
See the “Configuring Dual NICs in the Cisco Unity Server” section on page 5-9.

9. Configure TCP/IP properties, even if the server is not connected to the network. See the 
“Configuring TCP/IP Properties” section on page 5-10.

10. If the system has a network connection: Confirm that the server has a valid IP address and is 
connected to the network. See the “Verifying the IP Address and the Network Connection” section 
on page 5-11.

11. Change folder settings in Windows Explorer so that all files and folders are visible during 
Cisco Unity troubleshooting, if applicable. See the “Changing Folder Settings in Windows 
Explorer” section on page 5-11.

12. If virus-scanning software or Cisco Security Agent for Cisco Unity is installed on the Cisco Unity 
server: Disable virus-scanning services and Cisco Security Agent for Cisco Unity. See the 
“Disabling Virus-Scanning and Cisco Security Agent Services” section on page 5-12.
5-1
lation Guide (With Microsoft Exchange)



Chapter 5 Customizing the Cisco Unity Platform
Running the Cisco Unity System Preparation Assistant
13. Install Microsoft Active Directory, or add the Cisco Unity server to an existing domain. See the 
“Installing Active Directory or Adding the Cisco Unity Server to an Existing Domain” section on 
page 5-13.

14. If the system is using failover: Reset the account that SQL Server services log on as. See the 
“Resetting the Account That SQL Server Services Log On As” section on page 5-15.

When you are finished with this chapter, return to Chapter 1, “Overview of Mandatory Tasks for 
Installing Cisco Unity” to continue installing the Cisco Unity system.

Note The tasks in the list reference detailed instructions in the Cisco Unity Installation Guide and in other 
Cisco Unity documentation. Follow the documentation for a successful installation.

Running the Cisco Unity System Preparation Assistant
The Cisco Unity System Preparation Assistant is a program that helps customize the platform for 
Cisco Unity by checking for and installing Windows 2000 Server components, Microsoft service packs 
and updates, and other software required by Cisco Unity. For a detailed list, refer to Components and 
Software Installed by the Cisco Unity Platform Configuration Discs and the Cisco Unity System 
Preparation Assistant at 
http://www.cisco.com/univercd/cc/td/doc/product/voice/c_unity/pcd/pcdunty.htm.

Caution If you are installing Cisco Unity on a server running Windows 2000 Server, do not run the Cisco Unity 
System Preparation Assistant remotely by using Windows Terminal Services or other remote-access 
applications, or the installation of required software may fail.

Caution If you are installing Cisco Unity on a server running Windows Server 2003, do not run the Cisco Unity 
System Preparation Assistant over the network, and do not run it remotely by using Windows Terminal 
Services or other remote-access applications, or the installation of required software may fail.

To Run the Cisco Unity System Preparation Assistant

Step 1 Log on to Windows by using an account that is a member of the Local Administrators group.

Step 2 On Cisco Unity Service Packs CD 1, or from the location to which you saved the downloaded Service 
Packs CD 1 image files, browse to the Cuspa directory, and double-click Cuspa.vbs.

If you are accessing the Cisco Unity System Preparation Assistant files on another server, use Windows 
Explorer or the “net” command to map the network drive to a drive letter on the Cisco Unity server 
before you run Cuspa.vbs.

Step 3 If prompted, double-click the language of your choice to continue the installation.

Step 4 On the Welcome screen, click Next.
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Step 5 On the Cisco Unity Server Characteristics page, set the following fields:

Step 6 Click Next. The assistant lists the components and indicates whether or not they are installed.

Step 7 Follow the prompts to install any missing components until you are prompted to install the data store.

If a Microsoft AutoMenu window appears when the assistant is installing an application, close the 
window and allow the assistant to continue.

Step 8 If MSDE is being installed, skip to Step 9.

If SQL Server is being installed, install it in the location you made note of in the “Determining the Drive 
Locations for Files on the Cisco Unity System” section on page 2-5:

a. In the Welcome dialog box, click Next.

b. In the Computer Name dialog box, click Next to accept the default setting Local Computer.

c. In the Installation Selection dialog box, click Next to accept the default setting Create a New 
Instance of SQL Server, or Install Client Tools.

d. Follow the on-screen prompts until the CD Key dialog box appears.

e. Enter the key for Cisco Unity Data Store 2000 from the sticker located on the CD sleeve, and click 
Next.

f. In the Installation Definition dialog box, click Next to accept the default setting Server and Client 
Tools.

g. In the Instance Name dialog box, check the Default check box.

h. Click Next. 

i. In the Setup Type dialog box, click Typical.  

j. Under Destination Folder, next to Program Files, click Browse and specify the location for binaries 
that you made note of in the “Determining the Drive Locations for Files on the Cisco Unity System” 
section on page 2-5.  

k. Under Destination Folder, next to Data Files, click Browse and specify the location for databases 
that you made note of in the “Determining the Drive Locations for Files on the Cisco Unity System” 
section on page 2-5.  

l. Click Next.

m. At the top of the Services Accounts dialog box, click Use the Same Account for Each Service.

n. Under Service Settings, click Use the Local System Account.

o. Click Next.

Configuration Click Unified Messaging or Voice Messaging Only, depending on the Cisco Unity 
configuration.

Failover Check the This Is a Primary or Secondary Failover Server check box if the 
system is using failover.

The assistant uses the information to determine whether the system requires SQL 
Server or MSDE. If the system is using failover, SQL Server is required.

Number of Ports Enter the number of voice ports that you are connecting with the Cisco Unity server.

If the system is not using failover, the assistant uses the information to determine 
whether the system requires SQL Server or MSDE. For systems with more than 32 
ports, SQL Server is required. Otherwise, MSDE is required.
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p. In the Authentication Mode dialog box, we recommend that you click Windows Authentication 
Mode.

If you click Mixed Mode—which is supported but is less secure—under Add Password for the SA 
Login, enter and confirm a password for the SQL Server system administrator logon.

q. Click Next.

r. In the Start Copying Files dialog box, click Next.

s. In the Choose Licensing Mode dialog box, click Processor License For, and specify the number of 
processors in the Cisco Unity server.

t. Click Continue.

u. If you are prompted about shutdown tasks before continuing with the installation, click Next.

v. Click Finish.

w. Skip to Step 10.

Step 9 If MSDE is being installed, install it now:

a. Follow the on-screen prompts.

b. When the installation is complete, click Yes to restart the server.

Step 10 When SQL Server or MSDE installation is complete, continue following the on-screen prompts in the 
assistant to complete the platform customization.

Step 11 If MSDE Service Pack 3a is being installed, skip to Step 12.

If SQL Server Service Pack 3a is being installed, install it now:

a. On the Welcome screen, click Next.

b. Follow the on-screen prompts until you are prompted to choose the authentication mode.

c. Choose Windows authentication, and click Next.

d. If the SA Password Warning dialog box appears, enter and confirm the password, and click Next.

e. Check the Upgrade Microsoft Search and Apply SQL Server 2000 SP3 [Required] check box, 
and click Continue. (Do not check the Enable Cross-Database Ownership Chaining for All 
Databases [Not Recommended] check box.)

f. Follow the on-screen prompts to continue.

g. If you are prompted about shutdown tasks before continuing with the installation, click Next. 

h. Click Finish to begin installing components.

i. When the Setup message appears, click OK.

j. Click Finish to restart the server.

k. Skip to Step 13.

Step 12 If MSDE Service Pack 3a is being installed, install it now:

a. Follow the on-screen prompts.

b. When the installation is complete, click Yes to restart the server.

Step 13 Follow the on-screen prompts.
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Step 14 When the Cisco Unity System Preparation Assistant has completed, click Finish.

Caution When the Cisco Unity System Preparation Assistant installed Internet Explorer, it also 
automatically installed the file WScript.exe. Do not remove WScript.exe, or the Cisco Unity 
Setup program will fail later in the installation process.

Installing Administration Software for MSDE 2000 and Setting 
the MSDE System Administrator Password

Note If the system is not using MSDE 2000, skip this section.

When the Cisco Unity System Preparation Assistant installs MSDE 2000, it does not include 
administration software. You install Enterprise Manager administration software so that Cisco TAC can 
access the Cisco Unity MSDE databases during troubleshooting.

For security reasons, we highly recommend that you set a non-blank MSDE system administrator (sa) 
password. By default, the sa password is blank. After you install Enterprise Manager, you can use it to 
reset the sa password.

Do the following two procedures in the order listed.

To Install Enterprise Manager for MSDE

Step 1 After the server restarts (it was restarted in the preceding procedure), log on to Windows.

Step 2 If the Cisco Unity Data Store 2000 CD does not run automatically, browse to the root directory, and 
double-click Autorun.exe.

Step 3 Click SQL Server 2000 Components.

Step 4 Click Install Database Server.

Step 5 In the Welcome dialog box, click Next.

Step 6 In the Computer Name dialog box, click Next to accept the default setting Local Computer.

Step 7 In the Installation Selection dialog box, click Next to accept the default setting Create a New Instance 
of SQL Server, or Install Client Tools.

Step 8 Follow the on-screen prompts until the CD Key dialog box appears.

Step 9 Enter the key for Cisco Unity Data Store 2000 from the sticker located on the CD sleeve.

Step 10 Click Next.

Step 11 In the Installation Definition dialog box, click Client Tools Only.

Step 12 Click Next.

Step 13 In the Select Components dialog box, uncheck all check boxes in the Components list except 
Management Tools.

Step 14 Select Management Tools (but do not uncheck the check box).
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Step 15 In the Sub-Components list, uncheck all check boxes except Enterprise Manager, and click Next.

Step 16 In the Start Copying Files dialog box, click Next.

Step 17 Click Finish. 

To Set the Sa Password for MSDE

Step 1 On the Windows Start menu, click Programs > Microsoft SQL Server > Enterprise Manager.

Step 2 In the tree, expand Console Root\Microsoft SQL Servers\SQL Server Group\
(local)(Windows NT)\Security.

Step 3 Click Logins.

Step 4 In the right pane, right-click Sa, and click Properties.

Step 5 In the SQL Server Login Properties dialog box, click the General tab.

Step 6 Under SQL Server Authentication, enter the new password.

Step 7 Confirm the password, and click OK.

Step 8 Close Enterprise Manager.

Installing the Latest Microsoft Service Packs and Updates for 
Windows and SQL Server 2000/MSDE 2000

Install the latest Microsoft service packs (if any) and updates for Windows 2000 Server or Windows 
Server 2003 and for SQL Server 2000 or MSDE 2000 that are recommended for use with Cisco Unity. 
These are the service packs and updates that you downloaded in the “Downloading Software for the 
Installation” section on page 2-4.

Some Microsoft updates can be installed only after a prerequisite service pack has been installed. Install 
all of the latest Windows and SQL Server 2000/MSDE 2000 service packs recommended for use with 
Cisco Unity, if any, before you install updates.

Exchange software is not installed, so you cannot install Exchange service packs and updates yet.

To Install the Latest Microsoft Service Packs for Windows and SQL Server 2000/MSDE 2000

Follow the instructions that you printed or downloaded when you downloaded the service packs.

To Install the Latest Microsoft Updates for Windows and SQL Server 2000/MSDE 2000

Step 1 Browse to the location of the downloaded Microsoft updates, or insert the Cisco Unity Post-Install disc 
in the CD-ROM drive.
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Step 2 Browse to each of the applicable directories and install the correct language version of each update: 
English (ENU), French (FRA), German (DEU), or Japanese (JPN). (For example, if the French version 
of Windows 2000 Server is installed on the Cisco Unity server, install the French version of any 
Windows 2000 Server updates.)

To speed the installation, you may want to:

• Install each update at a command prompt by using the /z option, so you do not have to restart the 
computer after installing each update.

• Install each update at a command prompt by using the /m option, so the update installs without 
displaying any dialog boxes.

• Create a batch file that installs all of the updates at once.

For more detailed information, refer to Microsoft Knowledge Base article 296861, How to Install 
Multiple Windows Updates or Hot Fixes with Only One Reboot.

Step 3 Restart the Cisco Unity server.

Disabling the Found New Hardware Wizard for the Voice Cards
In the following cases, the Found New Hardware wizard may appear each time the server is restarted and 
report that the cards are new hardware, even though the cards are properly installed and configured:

• The operating system was installed by using the Platform Configuration discs.

• The operating system was installed by using the manufacturer’s guided system-setup utility before 
the cards were installed.

• New cards were added to an existing server.

Do the following procedure to prevent the Found New Hardware wizard from reporting the cards as new 
hardware. The procedure will not prevent the Found New Hardware wizard from finding and reporting 
other new hardware.

To Disable the Found New Hardware Wizard for the Voice Cards

Step 1 On the Found New Hardware wizard Welcome page, click Next. (After the server is restarted, the Found 
New Hardware wizard Welcome page is displayed along with the PCI Device Installing dialog.)

Step 2 On the Install Hardware Device Drivers page, click Search for a Suitable Driver for My Device 
(Recommended), and click Next.

Step 3 On the Locate Driver Files page, check the Floppy Disk Drives and CD-ROM Drives check boxes, and 
click Next.

Step 4 On the Driver Files Search Result page, click Disable the Device, and click Finish. Do not choose to 
skip driver installation of this device, or the Found New Hardware wizard will continue to appear each 
time the server is restarted.
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Step 5 Repeat Step 2 through Step 4 for each instance of the Found New Hardware wizard (for each card, as 
applicable).

Note that doing this procedure does not prevent a card from being displayed as an unknown PCI device 
when viewed in the Windows 2000 Device Manager. The warning that the device drivers are not installed 
also will continue to be displayed. This is expected behavior, and does not indicate a problem with the 
card or with the server.

Installing Virus-Scanning Software (Optional)
For information on supported virus-scanning software, refer to Cisco Unity 4.0 System Requirements, 
and Supported Hardware and Software at 
http://www.cisco.com/univercd/cc/td/doc/product/voice/c_unity/sysreq/40_sysrq.htm.

Follow the manufacturer instructions to install the virus-scanning software.

Note that scanning individual Exchange mailboxes can affect the performance of Cisco Unity.

Caution Do not configure virus-scanning software to block WAV attachments, or voice messages will be stripped 
of their recordings.

Installing and Configuring Cisco Security Agent for Cisco Unity 
(Optional)

Cisco Security Agent for Cisco Unity is available on Cisco.com. For information on how to download 
it, install it on the Cisco Unity server, and configure it, refer to Release Notes for Cisco Security Agent 
for Cisco Unity at 
http://www.cisco.com/en/US/products/sw/voicesw/ps2237/prod_release_notes_list.html.

Connecting the Cisco Unity Server to the Network
Connecting the Cisco Unity server to the network is optional for some configurations, but is required if 
you are:

• Integrating Cisco Unity with Cisco CallManager, a Cisco SIP Proxy Server, or Cisco CallManager 
Express.

• Installing Cisco Unity in the Unified Messaging configuration

• Homing Exchange mailboxes for any Cisco Unity subscribers on a separate Exchange server.

• Configuring Cisco Unity failover.

• Allowing users to access voice messages by using the Cisco Unity Inbox.

• Allowing users to change settings by using the Cisco Unity Assistant

• Allowing users to use their phones as a recording and playback device (TRaP).

• Integrating Cisco Unity with any other voice messaging system.
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Connecting the Cisco Unity server to the network is also necessary if you want the Cisco Unity server 
to have access to network utilities, for example, virus scanning or backup utilities.

To Connect the Cisco Unity Server to the Network

Attach the network cable(s) to the Cisco Unity server.

Configuring Dual NICs in the Cisco Unity Server

Note If the Cisco Unity server is not using dual NICs, skip this section.

We recommend that dual NICs be configured in adapter fault tolerant mode (AFT) or network fault 
tolerant (NFT) mode. One NIC is designated as the primary and the other NIC as the secondary for 
active-passive fault tolerance. In this configuration, the primary (active) NIC handles 100 percent of the 
traffic. Only in the event that the primary NIC becomes unavailable does the secondary NIC then become 
active and handle 100 percent of the traffic.

Alternatively, if you do not want to configure AFT or NFT, or do not have a second LAN port available, 
the following configurations are supported, though not recommended:

• Disable TCP/IP for the second NIC, which allows you to re-enable the second NIC remotely if the 
first NIC fails. (Use the Network and Dial-up Connections Control Panel to disable TCP/IP for the 
second NIC.)

• Disable the second NIC in the BIOS.

Caution Note that not plugging a network cable into the second NIC is not sufficient. The NIC must be disabled 
in the BIOS, or Cisco Unity may not work properly.

To Configure Dual NICs in the Cisco Unity Server

Step 1 Configure the NICs—or verify their configuration—so that:

• Both are connected to the same network segment.
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• Both share the same IP address.

• Both are set up for AFT or for NFT. Refer to the documentation provided by the NIC 
manufacturer or server vendor.

If you are configuring a Cisco MCS-7825H, MCS-7835H, or MCS-7845H server, configure 
NFT teaming by using the network teams property sheet of the Compaq Network Teaming and 
Configuration Utility (CPQNTAC, also known as NCU). The CPQNTAC utility is installed from 
the Hewlett-Packard SmartStart disc that was shipped with the server, by using the Remote 
Deployment utility (RDU).

If you are configuring a Cisco MCS-7815I, MCS-7855I, or MCS-7865I server, configure AFT 
teaming by using the Advanced Control Suite of the Broadcom NetXtreme Ethernet utilities. 
For the Cisco MCS-7835I and MCS-7845I servers, configure AFT teaming by using the teaming 
wizard on the Advanced tab of the Intel PROSet II Ethernet utilities.

Step 2 Restart the Cisco Unity server for any changes to take effect.

Configuring TCP/IP Properties
The Cisco Unity server must have an IP address and must also have the IP address of a DNS server, even 
if the Cisco Unity server is not connected to the network. Do the procedure in this section to specify IP 
addresses for the servers.

When selecting an IP address for the Cisco Unity server, note the following considerations:

• Do not select an address accessible from the Internet. Doing so can expose the Cisco Unity server 
to unwanted intrusion from the Internet, even when the server is hardened.

• Do not select an address that puts the Cisco Unity server on the opposite side of a firewall from:

– The Exchange server that Cisco Unity connects with.

– Any Exchange server that homes Cisco Unity subscribers.

– The domain controller/global catalog server that Cisco Unity accesses, if the Cisco Unity server 
is not a domain controller.

To Configure TCP/IP Properties

Step 1 On the Windows Start menu, click Settings > Control Panel > Network and Dial-Up Connections > 
Local Area Connection.

Step 2 Click Properties.

Step 3 In the Components Checked Are Used by This Connection list, check the Internet Protocol (TCP/IP) 
check box.

Step 4 Click Internet Protocol (TCP/IP) (but do not uncheck the check box), and click Properties.
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Step 5 Enter the applicable information, depending on whether the Cisco Unity server is connected to the 
network (for more information, refer to Windows 2000 Help):

Step 6 Click OK

Step 7 Restart the server.

Verifying the IP Address and the Network Connection

Note If the system does not have a network connection, skip this section.

To Verify the IP Address and the Network Connection

Step 1 On the Windows Start menu, click Programs > Accessories > Command Prompt.

Step 2 In the Command Prompt window, enter ipconfig /all, and press Enter.

Step 3 Verify the IP address of the Cisco Unity server.

Step 4 Find the IP address of a router or server on the same network segment as the Cisco Unity server.

If no routers or servers are listed, either you did not specify a default gateway when you assigned an IP 
address in the “Configuring TCP/IP Properties” section on page 5-10, or the Cisco Unity server is not 
connected to the network.

Step 5 Ping the router or other server whose IP address you found in Step 4. In the Command Prompt window, 
enter ping <IP address>, and press Enter.

If the device sends a reply, the Cisco Unity server has a valid IP address.

If the device does not reply, there may be a variety of causes. Some of the most common problems 
include:

• The assigned IP address conflicts with the IP address of another computer on the network.

• The subnet mask is incorrect.

Verify the network settings. If needed, troubleshoot any problem as you would a network connectivity 
problem.

Changing Folder Settings in Windows Explorer
You change folder settings so that all files and folders—including system files—are visible in Windows 
Explorer during Cisco Unity troubleshooting.

Cisco Unity server is connected 
to network

Enter IP addresses for the Cisco Unity server and for the preferred 
and alternate DNS servers.

Cisco Unity server is not
connected to network

Enter an IP address for the Cisco Unity server, and enter the same 
address in the Preferred DNS Server text box.
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If you installed Windows 2000 Server from the Platform Configuration discs that are shipped with a 
Cisco Unity server purchased from Cisco, all files and folders are already visible in Windows Explorer.

Note If you do not do the following procedure now, Cisco TAC may ask you to do it later.

To Change Folder Settings in Windows Explorer

Step 1 On the Windows desktop, double-click My Computer.

Step 2 On the Tools menu, click Folder Options.

Step 3 Click the View tab.

Step 4 Click Show Hidden Files and Folders.

Step 5 Uncheck the Hide File Extensions for Known File Types check box.

Step 6 Uncheck the Hide Protected Operating System Files check box, and click Yes to confirm.

Step 7 Click Apply.

Step 8 Click Like Current Folder, and click Yes to confirm.

Step 9 Click OK.

Disabling Virus-Scanning and Cisco Security Agent Services

Note If the system is not using virus-scanning software or Cisco Security Agent for Cisco Unity, skip this 
section.

You disable virus-scanning and Cisco Security Agent services on the server so that they do not slow 
down the installation of software or cause the installations to fail. The Cisco Unity Installation Guide 
alerts you when to re-enable the services after all of the installation procedures that can be affected are 
complete.

To Disable and Stop Virus-Scanning and Cisco Security Agent Services

Step 1 Refer to the virus-scanning software documentation to determine the names of the virus-scanning 
services.

Step 2 On the Windows Start menu, click Programs > Administrative Tools > Services.

Step 3 Disable and stop each virus-scanning service and the Cisco Security Agent service:

a. In the right pane, double-click the service.

b. On the General tab, in the Startup Type list, click Disabled. This prevents the service from starting 
when you restart the server.
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c. Click Stop to stop the service immediately.

d. Click OK to close the Properties dialog box.

Step 4 When the services have been disabled, close the Services MMC.

Installing Active Directory or Adding the Cisco Unity Server to 
an Existing Domain

The Cisco Unity server must be either a member server in an existing domain or a domain controller in 
its own domain. Cisco Unity interactions with the message store do not allow the server to be in a 
workgroup.

This section contains procedures for installing Active Directory on the Cisco Unity server and for adding 
the Cisco Unity server as a member server in an existing domain. Do the procedure that is applicable to 
your installation. The message store does not support workgroups, so you must do one procedure or the 
other.

If the system is using failover, add both the primary and the secondary Cisco Unity servers to the same 
existing domain. Do not install Active Directory on either server.

If the Cisco Unity server will be the only server in the domain, you must install Active Directory. 
However, because Active Directory is a very processor- and memory-intensive application, if you are 
adding the Cisco Unity server to an existing domain, we strongly recommend that you do not also install 
Active Directory on the Cisco Unity server. Instead, do the procedure in the “Existing Domain” section 
on page 5-15. 

Active Directory

Note If the system is using failover, do the procedure in the “Existing Domain” section on page 5-15 instead.

Do the following procedure to install Active Directory on the Cisco Unity server and make it a domain 
controller.

To Install Active Directory on the Cisco Unity Server

Step 1 On the Windows Start menu, click Run, then enter Dcpromo, and press Enter.

Step 2 Click Next.
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Step 3 Follow the on-screen prompts until the Directory Services Restore Mode Administration Password 
dialog box appears.

If the system has no network connection, follow the on-screen prompts and use the values in Table 5-1.

For other configurations, consult the system administrator to determine how to set up the server.

Step 4 Click Next.

Step 5 If the message “The wizard cannot contact the DNS server” appears, and the Cisco Unity server is 
connected to the network and the network has DNS installed and configured, skip to Step 6.

If the message “The wizard cannot contact the DNS server” appears and the Cisco Unity server is not 
connected to the network, install DNS:

a. Click OK to dismiss the message.

b. In the Configure DNS dialog box, click Yes, Install and Configure DNS on This Computer 
(Recommended).

c. Click Next.

d. Skip to Step 7.

Step 6 Troubleshoot DNS if the message “The wizard cannot contact the DNS server” appears, and the 
Cisco Unity server is connected to the network and the network has DNS installed and configured:

a. Click OK to dismiss the message.

b. Click Cancel to exit the Active Directory Installation wizard.

c. Troubleshoot the current DNS installation.

d. Return to Step 1 to start the procedure again.

Step 7 In the Directory Services Restore Mode Administration Password dialog box, enter and confirm a 
password.

Step 8 Click Next. 

Step 9 Review the settings, and click Next to install Active Directory.

Step 10 Click Finish.

Step 11 Click Restart Now.

Table 5-1 Dialog Box Values for a System That Has No Network Connection

Dialog Box Name Value

Domain Controller Type Domain Controller for a New Domain

Create Tree or Child Domain Create a New Domain Tree

Create or Join Forest Create a New Forest of Domain Trees

New Domain Name Consult the system administrator.

NetBIOS Domain Name Consult the system administrator.

Database and Log Locations If possible, choose separate hard disks for the 
database and the logs.

Shared System Volume Consult the system administrator.
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Existing Domain

Note If the system has no network connection, do the procedure in the “Active Directory” section on page 5-13 
instead.

Do the procedure in this section to add the Cisco Unity server to an existing domain without making it 
an additional domain controller in that domain. The domain controllers can be running Windows 2000 
Server or Windows Server 2003. 

We recommend that you install the Cisco Unity server in the same domain as the Exchange server that 
homes the Cisco Unity subscribers. 

To Add the Cisco Unity Server to an Existing Domain

Step 1 On the Windows Start menu, click Settings > Control Panel > System.

Step 2 Click the Network Identification tab.

Step 3 Click Properties.

Step 4 In the Identification Changes dialog box, click Domain, and enter the name of the domain that you want 
to join.

If you are setting up failover, add both Cisco Unity servers to the same domain.

Step 5 Click OK.

Step 6 In the Domain Username and Password dialog box, enter the name and password of an account that has 
permission to add computers to the domain.

Step 7 Click OK three times.

Step 8 Click Yes to restart the server.

Resetting the Account That SQL Server Services Log On As

Note If the system is not using failover, skip this section.

When you installed SQL Server, you set the services to use the local system account because the 
Cisco Unity server was not connected to the network. On both the primary and secondary servers for 
Cisco Unity failover, you must reset the account that the MSSQLServer and SQLServerAgent services 
log on as. The account must be a domain account and must:

• Have the right to log on as a service.

• Be a member of the Administrators local group.

To Reset the Account that SQL Server Services Log on As

Step 1 On the Windows Start menu, click Programs > Administrative Tools > Services.
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Resetting the Account That SQL Server Services Log On As
Step 2 Do the following eight substeps for each of the two services, MSSQLServer and SQLServerAgent:

a. In the right pane, double-click <Name of service>.

b. Click the Log On tab.

c. Click This Account.

d. Click Browse.

e. In the Select User dialog box, in the Look In list, click the name of the domain to which the 
Cisco Unity server belongs.

f. Double-click the name of the account to use. You must use the same account on both the primary 
and secondary Cisco Unity servers.

g. Enter and confirm the password.

h. Click OK.

Step 3 When you are done setting both accounts, close the Services window.
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